
 
 
 
 
 

Mabtech IRIS™ 
FluoroSpot/ELISpot reader 
 
 

ユーザーマニュアル 
 
 
 
 
 
 
 
 
 
 

© 2018 Mabtech 



 



Mabtech IRIS FluoroSpot/ELISpot reader User 
 

3  

  Contents 

目次 
 

目次 ................................................................................................... 3 

バックグラウンド ................................................................................... 5 

解析 ................................................................................................ 5 

ELISpot .................................................................................................... 5 

FluoroSpot ............................................................................................... 7 

Mabtech IRIS FluoroSpot/ELISpot リーダー ..................................... 7 

ELISpotの評価 .......................................................................................... 7 

FluoroSpotの評価 ..................................................................................... 8 

はじめに ............................................................................................. 9 

使用目的 .......................................................................................... 9 

規制情報 .......................................................................................... 9 

記号 .............................................................................................. 11 

ラベル ............................................................................................. 11 

クリーニング/除染 .............................................................................. 12 

廃棄 .............................................................................................. 12 

保証 .............................................................................................. 12 

安全性 ............................................................................................ 13 

製品説明 ........................................................................................ 15 

概観 .............................................................................................. 15 

梱包内容 ........................................................................................ 15 



4 Mabtech IRIS FluoroSpot/ELISpot reader User 
 

 

仕様 .............................................................................................. 16 

設置 ................................................................................................ 17 

ソフトウェア機能 ............................................................................... 19 

インターフェース ................................................................................. 19 

タブ ........................................................................................................... 19 

コマンドボタン .............................................................................................. 19 

Export ..................................................................................................... 19 

Preferences ............................................................................................. 20 

プレートテンプレート ........................................................................... 21 

管理者機能 .................................................................................... 22 

Firmware ................................................................................................ 22 

Handle users .......................................................................................... 22 

ELISpot解析手順 ........................................................................... 24 

ELISpotプレートの読み込み ............................................................... 24 

Plate View .................................................................................... 27 

Information ............................................................................................ 27 

View ........................................................................................................ 28 

Layout ..................................................................................................... 28 

Well overview ......................................................................................... 29 

Presets .................................................................................................... 29 

Comparison view ................................................................................... 31 

Individual well view ..................................................................... 32 

Orientation and information .................................................................. 33 

Filter ........................................................................................................ 33 

View ........................................................................................................ 33 



Mabtech IRIS FluoroSpot/ELISpot reader User 
 

5 
 

Layout ..................................................................................................... 34 

Tools ....................................................................................................... 34 

Well image ............................................................................................. 34 

Sliders/threshold settings ...................................................................... 35 

Information tabs .................................................................................... 35 

データの取扱 .................................................................................... 36 

Output files ............................................................................................. 36 

Excelでのデータ処理 ................................................................................... 37 

Prismでのデータ処理 .................................................................................. 37 

FluoroSpot解析手順...................................................................... 38 

FluoroSpotプレートの読み込み ......................................................... 38 

The plate view ............................................................................. 41 

Information ............................................................................................ 41 

View ........................................................................................................ 42 

Layout ..................................................................................................... 43 

Well overview ......................................................................................... 44 

Presets .................................................................................................... 45 

Comparison view ................................................................................... 46 

The individual well view .............................................................. 48 

Orientation and information .................................................................. 49 

Filter ........................................................................................................ 49 

View ........................................................................................................ 49 

Layout ..................................................................................................... 50 

Tools ....................................................................................................... 50 

Well image ............................................................................................. 50 

Sliders/threshold settings ...................................................................... 51 



6 Mabtech IRIS FluoroSpot/ELISpot reader User 
 

 

Information tabs .................................................................................... 51 

Data handlingデータの取扱 ............................................................. 52 

Excelでのデータ処理 ................................................................................... 53 

Data handling in Prism .......................................................................... 54 

修理、メンテナンスおよび輸送 .............................................................. 53 

参考文献 ......................................................................................... 55 

 



  Scientific background 

Mabtech IRIS FluoroSpot/ELISpot reader User 
 

5 

 

 

バックグラウンド 

解析 

ELISpot 
Enzyme-Linked ImmunoSpot（ELISpot）アッセイは、個々の細胞レベルでの検体分泌の検出を可

能にする高感度アッセイです（1）。ともとはB細胞による抗原特異的抗体の産生と分泌を測定するために設

計されていたが、後にサイトカインの検出に適用し、それにより他の免疫細胞の分析への道が開かれた。これ

には、通常サイトカイン産生による刺激に応答するT細胞を100,000細胞中にに約1個の検出限界で解析

することが可能になりました。T細胞が含まれていました。ELISpotは抗原特異的T細胞応答を解析するため

の理想的な方法として急速に広まりました（2）。 

優れた感度に加え、その簡単な手法により、ELISpotは、基礎的および臨床的免疫学研究の両方で非常に

重要で広く使用されるツールになりました。主な用途はワクチン開発で、B細胞とT細胞の両方による抗ワクチン

応答のモニタリングに頻繁に使用されます。このアッセイは診断にも使用されており、最も顕著な例は、TB抗原

特異的IFN-g分泌T細胞の検出に基づく結核（TB）感染の診断です（3） 

 

1. 抗体の固相化 
サイトカイン特異的モノクローナルキャプチャー抗体は、エタノール処理された

PVDFメンブレンプレートに固相化されています。 Mabtechのプレコートプレー

トを使用する場合、このステップは省略できます。 

 

 
2. 細胞とのインキュベーション 
細胞を活性化刺激の存在下もしくは非存在下で各ウェルに添加し、サイトカイン

分泌のためにインキュベートします。 

 

 
3. サイトカインの捕捉 
分泌されたサイトカインは、活性化された細胞を直接取り囲む膜上のキャプチャー

抗体に結合します. 
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4. 抗体検出 
細胞を除去し、プレートのウェルを洗浄した後、ビオチン化サイトカイン特異的検

出抗体をウェルに追加します。 

 
 
 

5. ストレプトアビジンー酵素複合体 
メンブレン上のスポットの形成を可能にするために、ストレプトアビジンー-酵素

複合体をウェルに追加されます。 

 
 

 
6. 基質の添加 
発色基質がウェルに添加され、酵素により触媒されると不溶性沈殿

物を形成され 単一の活性化細胞によるサイトカイン放出が可視化さ

れます。 

 
 

7. 解析 
スポットは自動ELISpotリーダーまたは解剖顕微鏡下でカウントされ、分

泌細胞の頻度が計算されます。 
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FluoroSpot 
FluoroSpotは、ELISpotアッセイの改変法であり、酵素ではなく蛍光によって検出が行われます（4）。

ELISpotのシンプルさと感度を維持しながら、蛍光色素を使用すると、多重化の可能性やスポット強度の

定量化の向上など、いくつかの重要な利点が得られます。ELISpotと同様に、細胞は96ウェルプレートで分

析されますが、膜をいくつかの異なるキャプチャー分子（たとえば、異なる抗サイトカイン抗体）でコーティング

することができ、検出は異なる標識の検出試薬で行われます。これらは、蛍光色素または別のタグ（たとえ

ば、別のペプチド）で直接標識することができます。タグを使用した場合、蛍光色素で標識された抗タグ抗

体による検出ステップを追加する必要があります。 

蛍光色素は、特定の波長の光にさらされたときに、暴露された光より長い波長の光を再放出できる分子で

す。 励起と発光に異なる特徴的な波長を表示する異なる蛍光色素を使用すると、異なる蛍光色素に

由来する蛍光信号を区別することが可能です。このようにして、それぞれが特定の蛍光色素によって表さ

れるいくつかの分析物を同じウェルで同時に検出することができ、異なる分析物を分泌する細胞を簡単に

識別してカウントすることができます。 

 
Mabtech IRIS FluoroSpot/ELISpot リーダー 
Mabtech IRIS FluoroSpot / ELISpotリーダーは、ELISpotとFluoroSpotの両方の分析用に特別

に設計されており、これらのメソッドの使用を改善および拡張する多数の新しい機能を有しています。プラグ

アンドプレイのパフォーマンス、直観的なソフトウェア、および便利なエクスポート機能と合わせて、Mabtech 

IRIS FluoroSpot / ELISpotリーダーは、現在存在するリーダーの中でも最も進化したリーダーです。 

 
ELISpotの評価 
ELISpotを読み取る手順はFluoroSpotの手順とよく似ていますが、ここではLEDの代わりにプレートを可

視白色光で照明し、白い膜の暗い沈殿物で表されるスポットをカメラセンサーで記録します。FluoroSpot

と同様に、ELISpotプレートを読み取ると、各ウェル内のスポットの数と、スポットのサイズと強度を反映する

ボリューム値が提供されます。 ただし、ELISpotではスポットボリュームのダイナミックレンジが制限されている

ため、FluoroSpotには、分泌される検体の量を評価する場合に大きな利点があります。 
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FluoroSpotの評価 
FluoroSpotプレートをMabtech IRIS FluoroSpot / ELISpotリーダーで分析すると、リーダーは発光ダ

イオード（LED）を使用してさまざまな蛍光色素を励起し、蛍光色素から放出された光はカメラによって生の

画像としてキャプチャーされます。励起光と放射光の両方に対して特定のフィルターと組み合わせて異なる

LEDを使用することにより、異なる蛍光色間の漏れこみを回避できます。 
Multi-secreting cells –スポット中心検出の重要性 

マルチカラープレートを分析する場合、各蛍光色素の画像が重ね合わされ、ソフトウェアは、異なる検

体を表すスポットが同じまたは異なる細胞に由来するかどうかを計算します。 複数の分泌細胞を正確

に定義するには、スポット中心の配置が非常に重要です。 RAWspotテクノロジーを使用することで、リ

ーダーはウェルで発生した分泌イベントを再現でき、分泌の原点、つまり膜上の分泌細胞の位置を非

常に正確に定義できます。 各蛍光シグナルにスポット中心が設定されているため、Mabtech Apexソ

フトウェアは、細胞が単一の検体を分泌するか、最大4つの異なる検体を分泌するかを正確に定義しま

す。 これにより、T細胞に適用した場合サイトカインプロファイルによって識別可能な最大15の異なる細

胞集団を定義できます。 

 
RSV – relative spot volume 

分泌細胞の数を定義することに加えて、Mabtech IRIS FluoroSpot / ELISpotリーダーは、分泌

された検体の相対量に関する情報を提供し、同じ検体を多かれ少なかれ分泌している細胞を正確に

区別できるようにします。 RAWspotテクノロジーは優れたダイナミックレンジを提供し、ウェル内のすべて

のスポットの平均RSV（相対スポットボリューム）値と、必要に応じて個々のスポットに対応する値の

両方を取得できます。 ただし、分泌されたサイトカインの正確な量ではなく相対量を示すので、RSV値

はサンプル間の同じ分析物についてのみ比較できます. 
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はじめに 

使用目的 
Mabtech IRIS FluoroSpot/ELISpotリーダーを使用することでフルオロスポットおよびエリスポット技術によ

る免疫反応の測定、すなわち単一細胞レベルでのアナライトの分泌を検出することが可能です。本リーダーで

は96ウェルマイクロタイタープレートが使用されます。Mabtechにより至適化された設定があらかじめインストー

ルされています。本システムは専用ソフトウェアMabtech ApexTMがインストールされているPC（Macもしくは

Windows）により制御され、解析を実行します。 

Mabtech IRIS FluoroSpot/ELISpotリーダーは研究用機器です。 
 

規制情報 
Mabtech IRIS FluoroSpot/ELISpotリーダーは下記の規制に準拠しています。 

指令 適用基準 
2014/30/EU – Electromagnetic 
Compatibility Directive (EMC) 

EN 61326-1, edition 3:2013-01-11 

 EN 61326-2-6, edition 2:2013-05-03 
 EN 55011, edition 4:2009-11-23 +A1:2010-

07-09 
 EN 61000-3-2, edition 4:2014-08-22 

EN 61000-3-3, edition 3:2013-08-23 
 EN 61000-4-2, -3, -4, -5, -6, -8 & -11 
2014/35/EU – Low Voltage Directive 
(LVD) 

EN 61010-1, edition 3:2010-10-15 

 EN 61010-2-101, edition 2:2017-02-24 
 EN 62471, edition 1:2008-09-12 
2011/65/EU – Restriction of 
Hazardous Substances Directive 
(RoHS) 

CENELEC EN 50581, edition 1:2012-09-21 

2006/42/EC – Machinery Directive 
(MD) 

 

FCC Part 15* §15.107 
 §15.109 
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*本機器はテスト済みであり、FCC規制パート15に基づくクラスBデジタル機器の制限に準拠していること

が確認されています。これらの制限は住宅地での設置において有害な干渉に対する妥当な保護を提供

するように設計されています。この機器は、無線周波数エネルギーを生成、使用、および放射する可能性

があり、指示に従って設置および使用しない場合、無線通信に有害な干渉を引き起こす可能性がありま

す。ただし特定の設置で干渉が発生しないことを保証します。この機器がラジオやテレビの受信に有害な

干渉を引き起こしている場合は、機器の電源をオフにしてからオンにすることで判断できます。ユーザーは、

次の1つ以上の方法で干渉を修正することをお勧めします: 

• 受信アンテナの向きや位置を変えます。 
• 機器と受信機の距離を離します。 
• 受信機が接続されているものとは異なる回路のコンセントに機器を接続します。. 
• 販売店または経験豊富なラジオ/テレビ技術者に相談する。 
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記号 
本機器には下記の記号が使用されています。 

Symbol Description 
 

  
規制情報の項に記載されている指令に準拠しています。 

S/
N 

シリアル番号 

 

 ロット番号 
 

 
 

 

 
電子廃棄物、WEEEに準拠した処分 

 

 

警告：このシンボルがマークされているすべてのケースで、取扱説明書を参照する必要
があります。 

 

ラベル 
本体ラベル: 
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クリーニング/除染 
Mabtech IRIS FluoroSpot/ELISpotリーダーのクリーニングが必要な場合は湿らせた布をご使用く
ださい。本リーダーをバイオハザード物質に直接接触させないでください。また、バイオハザードサンプルや
バイオハザード試薬を本リーダーで使用することはできません。 
システムを第三者に送る前に、汚染除去証明書を記入して、機器に潜在的な汚染物質が含まれて
いないことを確認してください。 

警告：本機器でバイオハザード物質を使用することはできません。 

 
詳細についてはwww.mabtech.comを参照してください。 

 
Mabtechは、生存可能な生物剤、有害な量の化学物質または放射性物質などのバイオハザード
物質で汚染されている可能性のある機器または部品を受け入れることができないことに注意してくださ
い。 
廃棄 

リーダーの寿命が尽きたら、指定された地元の電気および電子機器の受け取り場所でリーダ

ーをリサイクルしてください。 リーダーを家庭ごみとして廃棄しないでください。 廃電気電子機

器（WEEE）の処分の詳細については、www.mabtech.comを参照してください。 

 
保証 

www.mabtech.comにあるMabtechの一般販売条件または販売者と購入者の間の契約上の
合意を参照してください。 

 

注意! このマニュアルに記載に従わず使用した場合は、保証は無効となります。 
 

注意! リーダーを組み込んだシステムまたは機器の安全性は、Mabtech IRIS FluoroSpot / 

ELISpotリーダーをそのシステムまたは機器に接続する人の責任です。 

   



Mabtech IRIS FluoroSpot/ELISpot reader User 
 

13 

 

 

  Safety 

安全性 
システムを設置または操作する前に、安全情報を読む必要があります。 このマニュアルの指示に従って

ください。指示に従わないと、ユーザーのリスクやシステムの損傷を引き起こす可能性があります。 

警告! 指示に従わない場合、人身傷害の危険があります。 

注意! 指示に従わない場合、物的損害の危険があります。 

情報: システムの最適な使用に関する一般情報またはヒント。 

警告! Mabtech IRIS FluoroSpot / ELISpotリーダーを使用するには適正なトレーニングを受ける必

要があります。 

警告! 紫外線による目への損傷の危険がありますのでリーダーのカバーは取り外さないでください！ すべて

の内部修理とメンテナンス作業は、トレーニングを受けた技術者が行う必要があります。 詳細については、

販売店までお問い合わせください。 

警告! 火災の原因となりますので、システムの近くで不燃性および引火性の液体を使用または保管

しないでください!  

警告! 指を負傷する可能性がありますので、マイクロタイタープレートをリーダーに入れるときは注意してくださ

い！ 

警告! 紫外線により目に傷害を受ける可能性がありますので、スキャン中は機械の内部を見ないでく

ださい。 

警告! 人への傷害もしくはシステムの損傷を与える可能性がありますので、リーダーを持ち上げたり移

動したりするときは、このマニュアルの指示に従ってください!  

警告! 装置はバイオハザード物質と一緒に使用できません! 

警告! 強力な電磁放射の発生源（シールドされていない意図的なRF発生源など）の近くで機器を使

用しないでください。これらは機器の動作を妨害する可能性があります。 

警告! 感電及びシステムの損傷の恐れがありますので、故障した機器をシステムに接続しないでく

ださい。 

警告! 感電の恐れがありますので、システムを設置するときは、すべてのケーブルを正しく接続してください! 

 

警告! 電源を切断するには、電源ケーブルのいずれかの端を取り外します。 プラグを壁のソケットから簡単

に外せるようにリーダーを置いてください。 
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Safety  

注意! 「仕様」で指定されたタイプのマイクロタイタープレートのみを使用してください。 他のプレートを使用する

と、誤動作や電気的故障の原因となります。 

注意! リーダー回路がショートする恐れがありますので、液体を含むマイクロタイタープレートを挿

入しないでください！ 

注意! リーダーの近くや上に物を置かないでください！ リーダーからの振動により落下する可能性がありま

す。 
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  Product description 

製品説明 

概観 
 
 
 

 
 
 

番号    説明 番号    説明 

1 本体カバー 5 USBポート 

2 電源ボタン 6 Ethernetポート 

3 プレートローダーハッチ 7 電源ケーブルポートおよびヒューズソケッ
ト 

4 プログラムスイッチ (通常は１にセット)   

梱包内容 
パッケージには下記の物品が含まれています。 

• Mabtech IRIS FluoroSpot/ELISpot リーダー本体 
• USB ケーブル 
• Ethernetケーブル 
• 電源ケーブル 
• スペアヒューズ 

• 操作マニュアル 
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Product description  

仕様 
項目 仕様値 

電源  

AC入力電圧 100～240 VAC 

AC入力電流 1 A @100–240 VAC（最大） 

AC周波数 50～60 Hz 

DC入力電圧 5 VDC, 0.5 A（最大） 

消費電力 100 W（最大） 

Fuses Quick-Acting F4A H, 250 VAC (H = High 
Breaking Capacity (Ceramic Tube)) 

O&Mインターフェース 1 RJ45 port LAN 1000BASE-T 
 1 USB 2.0 port 

外寸 (H × W × D) 505 mm × 430 mm × 400 mm 

重量 20–25 kg 

使用環境 国内のみでの使用, +5ºC～+40ºC (+41ºF to +104ºF) 

標高2000 m以下 

相対湿度: 5～95% 
汚染度 ２ 

入力電圧許容誤差 +/-10% 

過渡過電圧 OVERVOLTAGE CATEGORY ll 
Surge Level 3 (CM 12 ohm) & 4 (DM 2 ohm): 2 kV– 
1.2/50 µs 

IPクラス IP20 

主な特徴  

解析速度 96秒/プレート 

解像度 (H × W) 2048 × 2048 pixels 

露光時間 300 ms 

データ通信速度 700 ms 

使用可能なプレート 96-well filter plates with 0.45 µm PVDF 
membrane; IPFL, MSIP or MAIPSWU10 (with 
an adapter) 

Mabtech IRIS FluoroSpot/ELISpotリーダーの使用にはMabtech Apex softwareがインストールされたPC

が必要となります。
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  Setup and installation 

設置 
警告! 人への傷害もしくはシステムの損傷を与える可能性がありますので、リーダーを持ち上げたり

移動したりするときは、このマニュアルの指示に従ってください!  

警告! 火災の原因となりますので、システムの近くで不燃性および引火性の液体を使用または保管
しないでください! 

注意! リーダー本体は重いので、頑丈なテーブルの上に設置してください。またリーダーの持

ち上げおよび移動は2名で行ってください。  

注意! 加熱による誤動作の恐れがありますので、他の機器はリーダーから10 cm以上離してくださ

い！ 

情報: サービスのためにシステムをMabtechに送る必要がある場合に備えて、パッケージを保管してくださ

い 
 
 

 

 
1. ハンドルを持ってボックスからMabtech IRIS 

FluoroSpot / ELISpotリーダーを持ち上げます。 
2. Mabtech IRIS FluoroSpot / ELISpotリー

ダーを頑丈なテーブルに水平に置きます。 内側

のパッケージを取り外します。 「梱包内容」セクシ

ョンで指定されたすべての物品を受け取ったこと

を確認してください。 
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Setup and installation  
 

3. USB、Ethernet、および電源ケーブルを接続します。（詳細は操作マニュアル参照） 

 

警告! 感電及びシステムが損傷する恐れがありますので機器は正しく接続してください。 

 

注意! Mabtech IRIS FluoroSpot / ELISpotリーダーを接地されたコンセントに接続します。 

入力電圧は、100～240 VAC、50～60 Hzでなければなりません。 
 

 
4. 電源ボタンを押してリーダーの電源を入れます。 



  Generic software 
 

Mabtech IRIS FluoroSpot/ELISpot reader User 
 

19 

 

 

ソフトウェア機能 

インターフェース 

タブ 
開いた各プレートまたは個々のウェルは、画面上部のタブに表示されます。 別のタブをクリックして、開い
ているプレートとウェルを参照します。 タブにカーソルを合わせ、[X]をクリックしてタブを閉じます。 

 
コマンドボタン 
上の行には、さまざまなコマンドを実行するためのボタンがあります。 

ボタン 使用 

New Plate 新しいプレートを加える 

Open 保存したプレートを開く 

Read 挿入したプレートを読み込む 

Recount スポットの再カウント 

Insert/Eje
ct 

プレートローダーの挿入/イジェクト 

Save 
現在のプレートを保存する。他の名前、他の場所にプレートをセーブする場合、
ファイルメニュから[Save as]を選択する。 

Export プレートもしくは個々のウェルのデータをエクスポートする。[Export]参照 

Preference
s 

Mabtech IRIS FluoroSpot / ELISpotリーダーの一般的な使用のための
設定を行います。[Preference]を参照してください。 

Export 
[エクスポート]メニューにはいくつかのオプションがあり、エクスポートされる内容は現在のビューによって異
なります。画像は、エクスポートを実行したときの外観（ズームレベル、明るさなど）でエクスポートされ
ます。 
Plate viewの場合 
ここでは、現在のプレートのデータをJPEG、TIF、またはExcel形式でエクスポートできます。 

同時に複数のプレートを開き、[Export]> [All Open Plates Excel]に移動すると、開いているす

べてのプレートのすべてのデータを含むExcelファイルがエクスポートされます。これを使用して、Excelで

ピボットテーブルを作成できます。
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Comparison viewの場合 
プレートビューで複数のウェルを選択し、右クリックして[Compare]> [new]を選択すると、選択し
たウェルが隣り合った個別のビューで開きます。 いくつかの表示設定を設定し、[Export]> 
[Comparison JPEG]または[Comparison TIF]を使用して、このビューをエクスポートできます。 
「Comparison view」を参照してください。 

 
Individual well viewの場合 
ここでは、個々のウェルのデータをJPEG、TIF、またはExcel形式でエクスポートできます。 オーバー
レイされたフィルターとウェル内の各スポットのRSV値を使用して、個々のウェルをエクスポートできます。 
スペースを節約するために、プレートの保存時にこのデータのすべてが通常エクスポートされるわけで
はありません。 

 
Preferences 
この項目には下記の2個のタブがあります。: 

• Presets 
• Save 

 
Presets 

このタブでは、すべてのプレートで使用できるさまざまなアッセイ缶の永続的なプリセットを作成できま

す。 管理者ユーザーが作成したプリセットはシステムプリセットになり、すべてのユーザーが使用でき

ます。「Administrator functions」を参照してください。  

ドロップダウンメニューを使用して、ELISpotプリセットの場合は白、FluoroSpotプリセットの場合は
LEDxxxを選択します。 [Create new Preset]をクリックしてプリセットを自分で作成するか、
[Nominate Plate Preset]をクリックして、開いているプレート用に作成されたプリセットを永続的な
プリセットに変換します。 

 
Save 

このタブでは、プレートを保存するときに含めるものまたは除外するものを選択できます。 

• GraphPad Prism file 
• すべての個々のウェルのJPEGデータ 
• FluoroSpotでのすべてのポピュレーションもしくは単一のポピュレーションのイメージ 
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プレートテンプレート 
プレートを読み取り、レイアウトやその他の設定を手動で作成する代わりに、既存のプレートをテンプ

レートとして保存し、それを使用して新しいプレートを読み取ることができます。 テンプレートには、次

のような情報を含めることができます。 

• どのウェルを読み込むか 
• どのフィルターを使用するか 
• どのレイアウトラベルを使用するか 
• どのプリセットを使用するか、等 

 
テンプレートの保存法: 

1. 再利用したい構成のプレートを開きます。 
2. ファイルメニューから[Export as Template]を選ぶ。 
3. テンプレートの名称を入力し、保存場所を選び[Save]をクリックする。 

 
テンプレートの読み出し法: 

1. [New Plate]タブ上の[Plate Template]をクリックする。 
2. [Add Template]をクリックして、保存されているテンプレートを参照します。 
3. テンプレートを選択し、[Import Template]をクリックする。 
4. [New Plate]タブのテンプレートをダブルクリックして開きます。 
5. [Read]をクリックして、テンプレートの設定でプレートを読み取ります。 
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管理者機能 
管理者ユーザーは、通常のユーザーがアクセスできない多くの設定にアクセスできます。 RAWデータでは露

光時間が非常に重要であるため、この設定は管理者ユーザーによって制御されます。 管理者は、ユーザー

を作成してパスワードをリセットすることもできます。 管理者が作成したプリセットは、（制限されていない限

り）すべてのユーザーが使用できるシステムプリセットになります。 

 

Firmware 
このボタンは、管理者ユーザーのウェルカム画面にのみ表示され、Mabtech IRIS FluoroSpot / 

ELISpotリーダーのファームウェアバージョンを確認できます。 ここからファームウェアのバージョンを更新するこ

ともできます。 

 

Handle users 
このボタンは、管理ユーザーのみのウェルカム画面に表示され、ユーザーを追加、編集、および削除できます。 

自分を含むユーザーのパスワードを変更することもできます。 
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新規ユーザーの追加: 

1. [Handle users]ボタンをクリックします。 
2. [Add User]をクリックするとポップアップウインドウが現れます。 
3. ユーザー名とパスワードを入力し、[OK]をクリックします。 
4. ユーザーに可能な制限を選択します。 
• あらかじめ定義されたレイアウト、プリセット、ウェルを含むテンプレートのみを実行するようにユーザー
を制限できます。 

• ユーザーが露光時間を変更できるかどうかを決定できます。 
• ユーザーが使用を許可されているデフォルトのプリセットを決定できます。 

5. 完了したら、[OK]をクリックします。 
 
ユーザーの編集: 

1. ユーザー名をクリックします。 
2. ユーザーの上記の制限を変更するもしくは、[Change password]をクリックしてパスワードを変更

します。完了したら、[OK]をクリックします。 

ユーザーの削除: 

1. ユーザー名をクリックします。 
2. [Remove User]ボタンをクリックします。 
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ELISpot解析手順 

ELISpotプレートの読み込み 

 
1. コンピューターを起動し、プログラムアイコンをダブルクリックします。 ログイン画面が表示されます。 

2. プロファイルを選択し、パスワードを入力します。[login]をクリックします。 
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3. [Open Workspace]をクリックします。 

 

4. Assay Principleでアッセイを選択するか、Plate Templatesでテンプレートをロードします。 
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5. [Eject]をクリックします。 リーダーからプレートローダーが出てきます。 

6. マイクロタイタープレートをプレートローダーに載せ、手動ロックシステムを使用してプレートを固

定します。 

7. Mabtech Apexにおいて読み込みたいウェルにマウスをドラッグして選択して[Read]をクリックしま

す。もしくはプレート全体を読み込みたい場合は直接[Read]をクリックします。プレートローダーが挿

入され、プレートが読み込まれスポットがカウントされます。 

 

8. Mabtech Apexで、[Save]をクリックして、解析を保存するフォルダーを選択します。[Save]をクリッ
クします。 
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Plate View 
プレートビューには以下のセクションが含まれます。 

 

Numbe
r 

Description 

1 Information 

2 View 

3 Layout 

4 Well overview 

5 Presets 
 

Information 
情報セクションの上部には、現在のプレートで使用されているアッセイのタイプと、プレートが保存されて

いる場所が表示されます。 下部には、現在のプレートに関するその他の情報が表示されます: 

• プレート名 
• Plate History：プレートに対して行われたすべてのことを確認できるボタン。完全な履歴には、最近の
履歴中にプレートに対して行われたすべてのアクションが表示されます。プレートが最後に開かれてからの
新しい変更を記録します。 [Esc]をクリックしてウィンドウを閉じます。 

• Plate Integrity: プレートが操作されていないことを確認できるボタン。[Esc]をクリックしてウィンドウを閉
じます。  

• The plate owner: 最初にプレートを読んだ人。 
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View 

ウェルの選択 
• All: プレート中のすべてのウェルを選択する。 
• None: プレート中のすべてのウェルの選択を解除する。 

 

フィルター 
ELISpotアッセイの場合、フィルターは常に白色LEDです。 必要に応じて、フィルター名を使用する分
析物の名前に置き換えることができます。「Preset」を参照してください。 元のフィルター名は、検体名の
後に括弧内に表示されます。 
 

Layout 

このセクションでは、プレート全体、プレートの一部、または実験を説明する個々のウェルに識別ラベルを追

加できます。 異なるカテゴリに属している限り、1つのウェルに複数のラベルを付けることができます。 ウェルに

ラベルを付けると、ExcelまたはGraphPad Prismでデータを簡単にソートできます。 

以前の実験のレイアウトを再利用する場合は、プレートを読み取る前にプレートテンプレートをロードします。 
「Plate Template」を参照してください。 
 

Category Use 

Analyte ウェルで使用したアナライトを特定します。 

Donor ウェルで使用した細胞を特定します。 

Cells/well ウェル中の細胞数を特定します。 

Stimuli ウェルで使用した刺激を特定します。 

Detection 検出系の濃度、タグ、基質、発色時間等の条件を特定します。 

Replicate
# 

リプリケート数を特定します。 

ウェルへのラベル追加: 

1. ラベルを作成するカテゴリに移動します（例：Analyte）。 
2. +記号をクリックします。 “New Label”という名前の新しいラベルが作成されます。 
3. 新しいラベルをクリックして名前を付けます。 ここに補足情報を追加することもできます。 
4. このラベルが付いたウェルには、特定の色が付けられます。 ボタンを使用してラベルの色を設定します選

択する色の横にあるクリックして変更します。 

5. ボックスの下部にあるミニチュアウェルビューで、ラベルを付けるウェルをクリックします。 

6. [OK]をクリックします。 ラベルボックスが閉じています。 
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特定のラベルが付いているウェルの確認: 

1. ラベルの前にある色付きの点をクリックします。 目のアイコンが点に表示され、色付きの枠がウェルの

概要でそのラベルが付いたすべてのウェルの周りに表示されます。 

 
Well overview 
このセクションでは、プレートの96ウェルを示します。 プレートを読み取ったり開いたりしない場合、ボック

スは空です。 プレートが開いているとき、読み取られたウェルとカウントされたウェルの画像がボックスに

表示されます。 スポット数はウェルID（A1からH12）の下に表示されます。 

個々のウェルをクリックして選択するか、マウスでドラッグして複数のウェルを選択できます。 選択したウェ

ルは、再度クリックするまで選択されたままになります。 選択したウェルを右クリックして、ポップアップメニュ

ーを表示できます。 このメニューでは、以下の項目について実行可能です: 

• 選択したウェルにプリセットを割り当てます。 [Presets]を参照してください。 
• 選択したウェルにレイアウトラベルを割り当てます。[Layout]を参照してください。 

• 選択したウェルを比較します。[Comparison View]を参照してください。 

個々のウェルの詳細を表示するには、ウェルの画像をダブルクリックします。 新しいウィンドウが開きま

す。[Individual Well View]を参照してください。 

 
Presets 
プリセットを使用すると、プレートのさまざまな部分にさまざまな設定（さまざまな強度、明るさ、コン

トラスト値など）を適用できます。 これは、たとえば、プレートの半分に1つのサイトカインがあり、もう

半分に別のサイトカインがある場合に役立ちます。 [Show Presets]ボタンをクリックして、どのウェ

ルでどのプリセットが使用されているかを確認します。 

スポットサイズの強調が異なる3つのデフォルトプリセットがあり、編集して新しいプリセットとして保存でき

ます。 異なる強調表示がRAWspotテクノロジー設定を制御します。Mabtech Default Normal

はほとんどの状況で使用でき、管理者ユーザーがユーザープロファイルに制限を加えていない限り、常に

デフォルトとして選択されます。 

ウィンドウの上部にアナライト名を追加できます。サイズと強度の設定により、どのスポットがカウントに
含まれるかが決まるため、これらの設定を変更するとスポットカウントに影響します。 スポット数はプレ
ートを再分析することなく、即座に更新されます。 一方、明るさ、コントラスト、色合いの設定は、視
覚表現にのみ影響します。 スポット数は影響を受けません。 
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新規プリセットの追加: 

1. [Add Preset]をクリックします。 新しいプリセットが作成されます。 
2. 新しいプリセットにカーソルを合わせ、[Edit]ボタンをクリックします。 設定ダイアログが開きます。 
3. プリセットに名前を付け、必要に応じて分析物名を入力します。 これにより、[View]> [Filters]に

表示される名前が変更されます。 

4. 必要に応じて、[Color]の下の[Click to change]ボタンをクリックして、プリセットの色を変更します。 
5. 必要に応じて、サイズ、強度、明るさ、コントラスト、色合いの設定を調整します。 
6. [Save & Click]をクリックしてプリセットを保存するか、[Cancel]をクリックして保存せずにダイアログを
終了します。 

 
プリセットの削除: 

1. 削除するプリセットにカーソルを合わせ、ごみ箱アイコンをクリックします。 プリセットが削除されます。 

選択したウェルはのプリセットの適用: 

1. [Well Overview]でウェルを選択します。 
2. 選択範囲を右クリックして、ドロップダウンリストから[Preset]を選択します。 

 
選択したウェルはのプリセットの削除: 

1. 目的のウェルを選択し、別のプリセットを選択します。 
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Comparison view 
専用ビューで2つ以上のウェルを比較できます。 

 
ウェルの比較: 

1. 比較するウェルを選択します。 
2. 右クリックして、[Compare]>[new]を選択します。 新しいタブが開き、選択したウェルのみが表
示されます。 

3. 必要に応じて調整を行い、[Export]をクリックしてウェルイメージをエクスポートします。 
 

 

 

調整 
• Viewにおいて: ウェルの表示方法を決定します: 

• Image: 画像を最小化し、画像をトリミングしてAOIのみを表示するか、画像内のスポットを強

調表示します。 最小化をアクティブにすると、エクスポートが無効になり、スポットが強調表示され

ず、表示するフィルターを変更できません。 この機能は、画像の概要と再編成を改善するための

ものです。 
• Data:  RSVエクスポートに含めるデータを決定します：スポット数、平均RSV、RSVの合計。 

• Layoutにおいて: エクスポートに含めるレイアウトラベルを選択します。”Layout”を参照してください。 
• Mniature viewにおいて: ウェルを比較に追加または削除します。 x記号をクリックすると、すべてのウ
ェルが削除されます。 

• comparison viewにおいて: 画像の上にある3本の線をクリックして押したままにして、画像を比較ビューの別の位
置にドラッグします。 
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Individual well view 
プレートビューで個々のウェルをダブルクリックすると、新しいビューが開き、個々のウェルの詳細が表示され

ます。 

 

 

Number Description 

1 Orientation and information 

2 Filter 

3 View 

4 Layout 

5 Tools 

6 Well image 

7 Sliders 

8 Information tabs 
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Orientation and information 
上部はプレート上のウェルの位置を示しています。 このビューでクリックすると、任意のウェルにジャンプで

きます。 

下部には3つのボタンがあります: 

• RAW Info: キャプチャーしてカウントされたRAW画像に関する基本情報。 
• Count Info: RAWspotテクノロジー設定に関する正確な情報。 

• MAX Values: 記録されたセンサー値。 ウェルによって生成された入力信号によってセンサーが飽和していないことを
確認するのに役立ちます。 ELISpotの最大値は4094です。最大値に達すると、警告記号が表示されます。 

 
Filter 
ELISpotアッセイの場合、フィルターは常に白色LEDです。 

 

View 
このセクションには、次のサブセクションが含まれています: 

 
Zoom 

ウェル画像を拡大（100％～3200％）できるドロップダウンメニュー。 
 

Image 

ウェル画像での関心領域の表示方法を決定する2つのトグルボタン: 

• Crop Image: 関心領域の外側にある画像の部分を表示または非表示にします。 
• Show AOI: 関心領域（AOI）を示す赤い円を表示または非表示にします。 

 
Relative Spot Volume (RSV) 

個々のウェルビューの右側の情報タブに何を表示するかを決定するトグルボタンのセット: 

• Average RSV: スポット情報タブでRSVを表示または非表示にします。 
• Sum of RSV: スポット情報タブですべてのカウントされたスポットの合計RSVを表示または非表示にします。 
• RSV Min-Max: スポット情報タブで最小および最大RSV値を表示または非表示にします。 

 
Show Layout Info 

個々のウェルビューの右側のLayout情報タブを表示または非表示にします。 
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Layout 
このセクションでは、個々のウェルビューの右側のLayout Informationタ

ブに表示される内容を決定します。 カテゴリをクリックして、このウェルのカテ

ゴリのラベルをLayout Informationタブに表示します。 この情報が表

示されていることを示す目の記号が表示されます. 

 
 

Tools 
このセクションには、スポット数に影響を与える2つのツールが含まれています: 

• マスクの編集 
• AOIの編集 

 
心領域の設定は、同じプリセットを持つすべてのウェルに影響し、ウェル画像のどの部分をカウントするかを

決定します。マスクは選択したウェルにのみ影響し、ウェル画像の一部をスポットカウントから除外するため

に使用されます。 

マスクの編集: 

1. [Edit mask]トグルボタンをオンに設定します。 
2. スポットカウントから除外するウェルイメージの部分の上にマウスでペイントします。 

3. [Set]をクリックしてマスクを保存します。 個々のウェルビューとプレートビューの両方で、ウェルの上部に

小さな消しゴムの記号が追加され、データが操作されたことを示します。 

4. マスクの一部を削除するには、[Remove]をクリックしてマウスでペイントします。 
5. マスク全体をクリアするには、[Clear]をクリックします。 

 
AOIの編集: 

1. [Edit area of interest]トグルボタンをオンに設定して、カウントされたウェルの領域を表示

します。 

2. 赤い円をドラッグして領域の位置を変更するか、[Edit Diameter]フィールドに新しい値を入力し

てサイズを変更します。 

Well image 
このセクションには、読み取りとカウントが表示されます。 
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注意: これらのスライダーを使用して、「Preset」セクションで説明されている手順の代わり

に、特定のプリセットの設定を変更できます。 

Sliders/threshold settings 
このセクションには、スポットカウントまたは視覚的表現に影響を与えるスライダーとボタンが含まれています。 

表示に影響を与えるスライダー/ボタン 

これらのスライダーはスポット数には影響しません。 現在のプリセットのすべてのウェルに影響します: 

• 明るさ 
• コントラスト 
• 色調 
スポットカウントに影響を与えるスライダー/ボタン 

これらのスライダーは、現在のプリセットのすべてのウェルに影響します: 

• サイズ 
• 強度 
• 強調(情報のみ、プリセットを変更すると変更されます)  
[Reset]ボタンを使用して、このプリセットのすべての値をデフォルトにリセットします。 

 

Information tabs 
このセクションには、2つの情報タブがあります。 ここに表示される情報は、左側の「View」と「Layout」

セクションの設定によって決まります（「Niew」と「Layout」を参照）。 

The Layout tab 
Layoutタブは、左側の[View]> [Data for Relative Spot Volume (RSV)]で[Lauout 

Info]をオンに切り替えた場合にのみ表示されます。 このタブには、選択したウェルに使用されているラ

ベルが表示されます。 この情報は、左側のLayoutセクションで対応するカテゴリがアクティブになってい

る（目のアイコンが表示されている）場合にのみ表示されます。
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The Spots tab 

このタブには、左側の[View]> [Data for Relative Spot Volume (RSV)]セクションの設定

によって決定されるスポットカウント情報が表示されます。 次の情報が表示されます: 

• 計測されたスポット数: ウェル内のスポット数 
• 平均RSV: ウェル内のスポットの平均RSV値. 
• Sum of RSV: ウェル内のスポットの総計RSV値. 

• RSV Min-Max: ウェル内のスポットの最大および最小RSV値.カウントされたスポットの中心を示す小さなドッ

トをウェル画像に表示するには、[White LED]ボタンをクリックします。 ウェルの画像でこれらのドットの1

つをクリックすると、ポップアップウインドウにスポットの座標、スポットの強度、スポットの直径、およびRSVが

表示されます。 複数のスポットを比較するには、Control / Ctrlキーを押しながらスポットをクリックします。 

 

データの取扱 

Output files 
プレートを保存すると、これらのファイルとサブフォルダーがターゲットフォルダーに作成されます。 
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File/folder Description 
[file name].pzfx Mabtech Apexで使用されるレイアウトに従ってスポット数をグループ化するGraphPad 

Prismファイル。 実験的なレイアウトがプレートに追加された場合にのみ作成されます。 
“Layout”を参照。 

[file name].xlsx プレートに関する一般情報とプレートデータベース、スポット形成単位、平均RSV（相対スポット
ボリューム）、RSV合計、レイアウト、露光に関する情報を含むExcelファイル。 

JPEG Plate (folder) プレート全体の画像（JPEG形式）。 

JPEG Well (folder) JPEG形式の個々のウェルの画像。 画像は、プレートを保存するときに使用される明るさとコント
ラストの設定を反映しています。 

Layout (folder) どのラベルがどのウェルに適用されているかを示す画像。 ラベルカテゴリごとに1つの画像がありま
す。 

Plate History 
(folder) 

プレートに加えられたすべての変更を示すログファイル。 プレートに変更が加えられた場合にのみ
作成されます。 

Presets (folder) どのプリセットがどのウェルに適用されているかを示す画像。 

RAW Data (folder) 高解像度と低解像度のすべてのウェルのRAW画像。 
 カウントデータフォルダー– RAWファイルが操作されていないことを確認するために使用されるシステ

ムファイルが含まれています。 このフォルダは削除しないでください！ 

 Well Maskフォルダー–システムファイルが含まれています。 マスクが適用されている場合にのみ
作成されます。 

 Plate.Infoファイル–プレートのデータ構造を記録します。 このファイルは削除しないでください！ 

WellMask (folder) マスクが適用されたウェルの画像。 マスクが適用されている場合にのみ作成されます。 

Excelでのデータ処理 
プレートを保存すると、次のタブでExcelファイルが作成されます: 

• Plate Information: プレート名、パス、読み取り日、エクスポート日、ユーザーなど 
• Plate Database: すべてのウェルからのすべてのデータの編集。 Excelでピボットテーブルを作成するのに             
便利です。 

• Spot Forming Units (SFU): 各ウェルのSFU値。 
• Average RSV: すべてのウェルの平均RSV値。 
• Sum RSV: すべてのウェルのカウントされたスポットの合計RSV値。 
• Layout: プレートに使用されているすべてのラベル、カテゴリごと (Layout参照). 
• Exposure: 露光時間(MS) 

Prismでのデータ処理 
Mabtech Apexで実験的なレイアウトを示すラベルを追加した場合、GraphPad Prismファイルを

使用して、実験を視覚的に表すグラフを作成できます。 Layoutを参照. 
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FluoroSpot解析手順 

FluoroSpotプレートの読み込み 
1. コンピューターを起動し、プログラムアイコンをダブルクリックします。 ログイン画面が表示されます。 

2. プロファイルを選択し、パスワードを入力します。[login]をクリックします。 
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3. [Open Workspace]をクリックします。 

 

4. Assay Principleでアッセイを選択するか、Plate Templatesでテンプレートをロードします。 
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5. [Eject]をクリックします。 リーダーからプレートローダーが出てきます。 

6. マイクロタイタープレートをプレートローダーに載せ、手動ロックシステムを使用してプレートを固

定します。 

7. Mabtech Apexにおいて読み込みたいウェルにマウスをドラッグして選択して[Read]をクリックしま

す。もしくはプレート全体を読み込みたい場合は直接[Read]をクリックします。プレートローダーが挿

入され、プレートが読み込まれスポットがカウントされます。 

 

8. Mabtech Apexで、[Save]をクリックして、解析を保存するフォルダーを選択します。[Save]をクリ
ックします。 

 



  FluoroSpot 
 

Mabtech IRIS FluoroSpot/ELISpot reader User 
 

41 

 

 

The plate view 
プレートビューには以下のセクションが含まれます。 

 

番号 内容 

1 Information 

2 View 

3 Layout 

4 Well overview 

5 Presets 

Information 
情報セクションの上部には、現在のプレートで使用されているアッセイのタイプと、プレートが保存されている

場所が表示されます。 下部には、現在のプレートに関するその他の情報が表示されます: 

• プレート名 
• Plate History: プレートに対して行われたすべてのことを確認できるボタン。完全な履歴には、最近の
履歴中にプレートに対して行われたすべてのアクションが表示されます。プレートが最後に開かれてからの
新しい変更を記録します。 [Esc]をクリックしてウィンドウを閉じます。 

• Plate Integrity: プレートが操作されていないことを確認できるボタン。[Esc]をクリックしてウィンドウを閉
じます。 
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• The plate owner: 最初にプレートを読んだ人。 

• Spot Joining Threshold: セルがダブル生産セルとして検出されなくなるまでの、異なるフィ
ルターの2つのスポットセンター間の最大ピクセル数。 

View 

ウェルの選択 
• All: プレート中のすべてのウェルを選択する。 
• None: プレート中のすべてのウェルの選択を解除する。 

 
Filters 

下部では、どのフ蛍光フィルターを表示するかを決定できます。 アッセイのタイプに応じて、次のフィルターを

利用できます: 

• LED380 
• LED490 
• LED550 
• LED640 

 
必要に応じて、フィルター名を使用する分析物の名前に置き換えることができます。「Preset」を参照してください。 

元のフィルター名は、検体名の後に括弧内に表示されます。 

ペン記号をクリックして、選択したフィルターを変更します。 プレートで使用されていないフィルターを選択した

場合、ウェル画像は表示されません。
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Layout 

このセクションでは、プレート全体、プレートの一部、または実験を説明する個々のウェルに識別ラベルを追

加できます。 異なるカテゴリに属している限り、1つのウェルに複数のラベルを付けることができます。 ウェルに

ラベルを付けると、ExcelまたはGraphPad Prismでデータを簡単にソートできます。 

以前の実験のレイアウトを再利用する場合は、プレートを読み取る前にプレートテンプレートをロードします。 

「Plate Template」を参照してください. 
 

 

 

 

 

 

 

 

 

ウェルへのラベル追加: 

1. ラベルを作成するカテゴリに移動します（例：Analyte）。 
2. +記号をクリックします。 “New Label”という名前の新しいラベルが作成されます。 
3. 新しいラベルをクリックして名前を付けます。 ここに補足情報を追加することもできます。 
4. このラベルが付いたウェルには、特定の色が付けられます。 ボタンを使用してラベルの色を設定します選

択する色の横にあるクリックして変更します。 

5. ボックスの下部にあるミニチュアウェルビューで、ラベルを付けるウェルをクリックします。 

6. [OK]をクリックします。 ラベルボックスが閉じています。 
 
特定のラベルが付いているウェルの確認: 

1. ラベルの前にある色付きの点をクリックします。 目のアイコンが点に表示され、色付きの枠がウェルの

概要でそのラベルが付いたすべてのウェルの周りに表示されます 

Category Use 

Analyte ウェルで使用したアナライトを特定します。 

Donor ウェルで使用した細胞を特定します。 

Cells/well ウェル中の細胞数を特定します。 

Stimuli ウェルで使用した刺激を特定します。 

Detection 検出系の濃度、タグ、基質、発色時間等の条件を特定します。 

Replicate
# 

リプリケート数を特定します。 
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Well overview 
このセクションでは、プレートの96ウェルを示します。 プレートを読み取ったり開いたりしない場合、ボックス

は空です。 プレートが開いているとき、読み取られたウェルとカウントされたウェルの画像がボックスに表示さ

れます。 スポット数はウェルID（A1からH12）の下に表示されます。 

個々のウェルをクリックして選択するか、マウスでドラッグして複数のウェルを選択できます。 選択したウェル

は、再度クリックするまで選択されたままになります。 選択したウェルを右クリックして、ポップアップメニュー

を表示できます。 このメニューでは、以下の項目について実行可能です: 

• 選択したウェルにプリセットを割り当てます。 [Presets]を参照してください。 
• 選択したウェルにレイアウトラベルを割り当てます。[Layout]を参照してください。 

• 選択したウェルを比較します。[Comparison View]を参照してください。 

 

個々のウェルの詳細を表示するには、ウェルの画像をダブルクリックします。 新しいウィンドウが開きま

す。[Individual Well View]を参照してください。 
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Presets 
FluoroSpotのプリセットを表示、編集、作成するには、左側の[View]> [Filter]でフィルタ

ーを1つだけ選択する必要があります。 フィルターごとに1つのデフォルトのプリセットがあります。 

編集して新しいプリセットとして保存できます。 

プリセットを使用すると、プレートのさまざまな部分にさまざまな設定（さまざまな強度、明るさ、

コントラスト値など）を適用できます。 これは、たとえば、プレートの半分に1つのサイトカインが

あり、もう半分に別のサイトカインがある場合に役立ちます。 [Show Presets]ボタンをクリッ

クして、どのウェルでどのプリセットが使用されているかを確認します。 

ウィンドウの上部にアナライト名を追加できます。 これは、FluoroSpotで使用されるさまざまな分

析対象を追跡するのに特に役立ち、Excelでピボットテーブルを簡単に作成できるようになります。 

サイズと強度の設定により、どのスポットがカウントに含まれるかが決まるため、これらの設定を変

更するとスポットカウントに影響します。 スポット数はプレートを再分析することなく、即座に更

新されます。 一方、明るさ、コントラスト、色合いの設定は、視覚表現にのみ影響します。 ス

ポット数は影響を受けません。 

新規プリセットの追加: 

1. [Add Preset]をクリックします。 新しいプリセットが作成されます。 
2. 新しいプリセットにカーソルを合わせ、[Edit]ボタンをクリックします。 設定ダイアログが開きます。 
3. プリセットに名前を付け、必要に応じて分析物名を入力します。 これにより、[View]> 

[Filters]に表示される名前が変更されます。 

4. 必要に応じて、[Color]の下の[Click to change]ボタンをクリックして、プリセットの色を変更します。 
5. 必要に応じて、サイズ、強度、明るさ、コントラスト、色合いの設定を調整します。 
6. [Save & Click]をクリックしてプリセットを保存するか、[Cancel]をクリックして保存せずにダ
イアログを終了します。 

 
プリセットの削除: 

1. 削除するプリセットにカーソルを合わせ、ごみ箱アイコンをクリックします。 プリセットが削除され

ます。 

選択したウェルへのプリセットの適用: 

1. [Well Overview]でウェルを選択します。 
2. 選択範囲を右クリックして、ドロップダウンリストから[Preset]を選択します。 
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選択したウェルのプリセットの削除: 

1. 目的のウェルを選択し、別のプリセットを選択します。 

 

Comparison view 
専用ビューで2つ以上のウェルを比較できます。 

 
ウェルの比較: 

1. 比較するウェルを選択します。 
2. 右クリックして、[Compare]>[new]を選択します。 新しいタブが開き、選択したウェルのみが
表示されます。 

3. 必要に応じて調整を行い、[Export]をクリックしてウェルイメージをエクスポートします。 
 

 

 

調整 
• Viewにおいて: ウェルの表示方法を決定します: 
• Image: 画像を最小化し、画像をトリミングしてAOIのみを表示するか、画像内のスポットを強調表示します。 最
小化をアクティブにすると、エクスポートが無効になり、スポットが強調表示されず、表示するフィルターを変更できません。 
この機能は、画像の概要と再編成を改善するためのものです。 

• Data: RSVエクスポートに含めるデータを決定します：スポット数、平均RSV、RSVの合計。 
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• Layoutにおいて: エクスポートに含めるレイアウトラベルを選択します。”Layout”を参照してください。 
• Miniature viewにおいて: ウェルを比較に追加または削除します。 x記号をクリックすると、すべて
のウェルが削除されます。 

• Comparison viewにおいて: 画像の上にある3本の線をクリックして押したままにして、画像を
比較ビューの別の位置にドラッグします。 
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The individual well view 
プレートビューで個々のウェルをダブルクリックすると、新しいビューが開き、個々のウェルの詳細が表示され

ます。 

 
 

Number Description 

1 Orientation 

2 Filter 

3 View 

4 Layout 

5 Tools 

6 Well image 

7 Sliders 

8 Information tabs 
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Orientation and information 
上部はプレート上のウェルの位置を示しています。 このビューでクリックすると、任意のウェルにジャンプでき

ます。 

下部には3つのボタンがあります: 

• RAW Info: キャプチャーしてカウントされたRAW画像に関する基本情報。 
• Count Info: RAWspotテクノロジー設定に関する正確な情報。 
• MAX Values: 記録されたセンサー値。 ウェルによって生成された入力信号によってセンサーが飽和
していないことを確認するのに役立ちます。 RAW画像とHDRテクノロジー組み合わせでの
FluoroSpotの最大値は16376となります。 最大値に達すると、警告記号が表示されます。 

 

Filter 
このセクションでは、個々のウェルについて表示する蛍光フィルターを決定できます。 

 

View 
このセクションには、次のサブセクションが含まれています: 

 
Zoom 

このセクションには、次のサブセクションが含まれています。 
 

Image 

ウェル画像での関心領域(AOI)の表示方法を決定する2つのトグルボタン: 

• Crop Image: 関心領域 (AOI)の外側にある画像の部分を表示または非表示にします。 
• Show AOI: 関心領域（AOI）を示す赤い円を表示または非表示にします。 

 

Data for Relative Spot Volume (RSV) 

個々のウェルビューの右側の情報タブに何を表示するかを決定するトグルボタンのセット: 

• Average RSV: スポット情報タブでRSVを表示または非表示にします。. 
• Sum of RSV: スポット情報タブですべてのカウントされたスポットの合計RSVを表示または非表示に
します。 

• RSV Min-Max: スポット情報タブで最小および最大RSV値を表示または非表示にします。 
Show Layout Info 

個々のウェルビューの右側のLayout情報タブを表示または非表示にします。 
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Layout 
このセクションでは、個々のウェルビューの右側のLayout Informationタ

ブに表示される内容を決定します。 カテゴリをクリックして、このウェルのカテ

ゴリのラベルをLayout Informationタブに表示します。 この情報が表

示されていることを示す目の記号が表示されます。 

 
 

Tools 
このセクションには、スポット数に影響を与える2つのツールが含まれています: 

• マスクの編集 
• AOIの編集 

 
関心領域の設定は、同じプリセットを持つすべてのウェルに影響し、ウェル画像のどの部分をカウントするか

を決定します。マスクは選択したウェルにのみ影響し、ウェル画像の一部をスポットカウントから除外するた

めに使用されます。 

マスクの編集: 

1. [Edit mask]トグルボタンをオンに設定します。 
2. スポットカウントから除外するウェルイメージの部分の上にマウスでペイントします。 

3. 3. [Set]をクリックしてマスクを保存します。 個々のウェルビューとプレートビューの両方で、ウェルの上部

に小さな消しゴムの記号が追加され、データが操作されたことを示します。 

4. マスクの一部を削除するには、[Remove]をクリックしてマウスでペイントします。 
5. マスク全体をクリアするには、[Clear]をクリックします。 

 
AOIの編集: 

1. [Edit area of interest]トグルボタンをオンに設定して、カウントされたウェルの領域を表示

します。 

2. 赤い円をドラッグして領域の位置を変更するか、[Edit Diameter]フィールドに新しい値を入力し

てサイズを変更します。 

Well image 
このセクションには、読み取りとカウントが表示されます。 
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注意: これらのスライダーを使用して、「Preset」セクションで説明されている手順の代わりに、特定のプリ

セットの設定を変更できます。 

Sliders/threshold settings 
このセクションには、スポットカウントまたは視覚的表現に影響を与えるスライダーとボタンが含まれていま

す。 スライダーは一度に1つのフィルターに影響します。 それらを使用するには、”Filter”セクションで1つ

のフィルターのみが選択されていることを確認してください。 

表示に影響を与えるスライダー/ボタン 

これらのスライダーはスポット数には影響しません。 現在のプリセットのすべてのウェルに影響します: 

• 明るさ 

• コントラスト 

• 色調 
スポットカウントに影響を与えるスライダー/ボタン 

これらのスライダーは、現在のプリセットのすべてのウェルに影響します: 

• サイズ 

• 強度 

[Reset]ボタンを使用して、このプリセットのすべての値をデフォルトにリセットします。 

 

Information tabs 
このセクションには、2つの情報タブがあります。 ここに表示される情報は、左側の「View」と「Layout」

セクションの設定によって決まります（「View」と「Layout」を参照）。 

The Layout tab 
Layoutタブは、左側の[View]> [Data for Relative Spot Volume (RSV)]で[Lauout Info]をオ

ンに切り替えた場合にのみ表示されます。 このタブには、選択したウェルに使用されているラベルが表示され

ます。 この情報は、左側のLayoutセクションで対応するカテゴリがアクティブになっている（目のアイコンが表

示されている）場合にのみ表示されます。
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The Spots tab 

このタブには、左側の[View]> [Data for Relative Spot Volume (RSV)]セクションの設定によって決定されるス

ポットカウント情報が表示されます。 次の情報が表示されます: 

• 計測されたスポット数: ウェル内のスポット数 
• 平均RSV: ウェル内のスポットの平均RSV値 
• Sum of RSV: ウェル内のスポットの総計RSV値. 

• RSV Min-Max: ウェル内のスポットの最大および最小RSV値. 

カウントされたスポットの中心を示す小さなドットをウェル画像に表示するには、[White LED]ボタンをクリック

します。 ウェルの画像でこれらのドットの1つをクリックすると、ポップアップウインドウにスポットの座標、スポット

の強度、スポットの直径、およびRSVが表示されます。 複数のスポットを比較するには、Control / Ctrlキ

ーを押しながらスポットをクリックします。 

サブセットの下のボタンをクリックして、表示するデータのサブセットを決定します。 さまざまな分析対象物の

平均スポットボリュームを比較するために使用できるドロップダウンメニュー[Perspective]もあります。 

 
Data handlingデータの取扱 
Output files 
プレートを保存すると、これらのファイルとサブフォルダーがターゲットフォルダーに作成されます: 
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File/folder Description 

[file name].pzfx Mabtech Apexで使用されるレイアウトに従ってスポット数をグループ化するGraphPad 
Prismファイル。 実験的なレイアウトがプレートに追加された場合にのみ作成されます。 
“Layout”を参照。 

[file name].xlsx プレートに関する一般情報とプレートデータベース、スポット形成単位、平均RSV（相対スポット
ボリューム）、RSV合計、レイアウト、露光に関する情報を含むExcelファイル。 

JPEG Plate 
(folder) 

プレート全体の画像（JPEG形式）。データのサブセットごとに1つのイメージが作成されます。 

JPEG Well 
(folder) 

JPEG形式の個々のウェルの画像。 画像は、プレートを保存するときに使用される明るさとコント
ラストの設定を反映しています。 

Layout (folder) どのラベルがどのウェルに適用されているかを示す画像。 ラベルカテゴリごとに1つの画像がありま
す。 

Plate History 
(folder) 

プレートに加えられたすべての変更を示すログファイル。 プレートに変更が加えられた場合にのみ
作成されます。 

Presets (folder) どのプリセットがどのウェルに適用されているかを示す画像。フィルターごとに1つの画像が作成されます。 

RAW Data 
(folder) 

高解像度と低解像度のすべてのウェルのRAW画像。 

 カウントデータフォルダー– RAWファイルが操作されていないことを確認するために使用されるシステ
ムファイルが含まれています。 このフォルダーは削除しないでください！ 

 Well Maskフォルダー–システムファイルが含まれています。 マスクが適用されている場合にのみ
作成されます。 

 Plate.Infoファイル–プレートのデータ構造を記録します。 このファイルは削除しないでください！ 

WellMask 
(folder) 

マスクが適用されたウェルの画像。 マスクが適用されている場合にのみ作成されます。 

Excelでのデータ処理 
プレートを保存すると、次のタブでExcelファイルが作成されます: 

• Plate Information: プレート名、パス、読み取り日、エクスポート日、ユーザーなど 
• Plate Database: すべてのウェルからのすべてのデータの編集。 
• Spot Forming Units (SFU): 各ウェルのSFU値 
• Average RSV380/490/550/640 (one tab for each filter): すべてのウェルの平均RSV値 
• Sum RSV380/490/550/640 (one tab for each filter): すべてのウェルのカウントされたスポッ
トの合計RSV値. 

• Layout: レートに使用されているすべてのラベル、カテゴリごと (Layout参照) 
• Exposure: 露光時間(ms) 
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Data handling in Prism 
Mabtech Apexで実験的なレイアウトを示すラベルを追加した場合、GraphPad Prismファイルを使用

して、実験を視覚的に表すグラフを作成できます。 Layoutを参照。 
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  Service, maintenance and transport 

修理、メンテナンスおよび輸送 

警告! 紫外線による目への損傷の危険がありますのでリーダーのカバーは取り外さないでく

ださい！ すべての内部修理とメンテナンス作業は、トレーニングを受けた技術者が行う必

要があります。 詳細については、販売店までお問い合わせください。 

注意! 該当するEMC要件に準拠するために、3 mより短いシールドされた信号ケー

ブルのみを使用してください。  USBケーブルが3 mより長い場合、リーダーとコンピュ

ーター間の接続が機能しなくなる可能性があります。  

注意! 以下に指定された部品のみを使用してください！ 他の部品を使用すると、保証が無効
になります. 

 
修理/サービス/輸送のために到着したときと同じ箱で機器を送り返します。 IEC 60068-2および       
IEC 60721- 3に準拠した輸送および保管の環境条件：公共交通機関：-40～+70ºC、保管
場所：-25～+55ºC。 
機器を修理/サービス/輸送のために使用しない場合は、www.mabtech.comを参照してください 

交換可能なパーツ: 

Part Description 

電源ケーブル 100 V/15 A 
 IEC 60320-1 C13コネクター 

Ethernetケーブル Shielded Ethernet cable (SFTP or STP) 
 Cat. 5e or 6A 
 RJ45 male – RJ45 male 
  

 

USBケーブル Shielded USB cable 
 Type A male – type B male 
  

 

Fuses x 2 Cartridge fuses SP 5×20 
 250V 4A 
 IEC 60127-2 
 Quick-Acting F, H (H = High Breaking Capacity (Ceramic Tube)) 
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Service, maintenance and transport  

ヒューズ交換: 
 

警告! 感電防止のため、電源ケーブルを必ず抜いてください。 

 
1. IECインレットから電源ケーブルを抜きます。 
2. マイナスドライバまたは類似の工具を使用して、IECインレットからヒューズホルダーを取り外します。 
3. ヒューズを交換します。 
4. ヒューズホルダーを元に戻し、電源ケーブルを差し込みます。 
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